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Tools Installation

1. XMC Flasher
2. XMC 4200 Serial Port Drivers

1. Radar GUI

1. DAVE
2. Segger J-Link

2017-08-01 Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary m



(infineon

Tools Installation

1. XMC Flasher
2. XMC 4200 Serial Port Drivers

Visualization Tool

1. Radar GUI

Firmware Development Tools

1. DAVE
2. Segger J-Link
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Flashing Tools infineon
1. XMC Flasher (feon

1. Download XMC Flasher .zip file from the following link

http://www.infineon.com/cms/en/product/microcontroller/32-bit-industrial-microcontroller-based-on-
arm-reqgistered-cortex-registered-m/xmc-development-tools-software-tools-and-partner/xmc-
programming-tools-from-infineon/channel.html?channel=5546d462557e6e890155a0532c605bfe

XMC™ Flasher

Products Atiny and free of charge tool for XMC™ MCU flash
Documents programm\'ng
Forums

The new XMC™ Flasher is a tiny, free of charge programming tool for on-chip flash programming. It is written in

Support Java and it supports basic functionalities like erasing, programming and verification (.hex and .srec), plus BMI
handling. XMC™ Flasher requires a J-Link compatible debug-HW to connect to the target (integrated on most of
the XMC™ Kits or XMC™ Link).

| o C—
Download here

2. Extract the downloaded .zip file and run the XMCFlasher.jar file

o e

Infineon-XMCFlasher-GS-v01_06-EN » XMCFlasher » ~ | 44 W Search XMCFlasher o)

Name Date modified Type Size
! Licenses 18.08.2017 09:43 File folder
-l XMCFlasher.bat 21.10.2016 15:28 Windows Batch File 1KB
XMCFlasherjar 09.06.2017 11:28 JAR File 25445 KB 6_
b 4 XMCFlasher_Installation_Instructions.pdf 00.06.2017 11:23 Adobe Acrobat D... 165 KB
b4 XMCFlasher_Release_Motes.pdf 09.06.2017 11:23 Adobe Acrobat D... 259 KB
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Flashing Tools infineon
1. XMC Flasher

Note: Might need to install Java (32-bit or 64-bit) to run the XMCFlasher.jar file.

https://java.com/en/download/

Search

Download  Help

(RIS Free Java Download

If you want to download

Java for another compiter Download Java for your desktop computer now!
or Operating System, click Version 8 Update 144

the link below.
All Java Downloads

Report an issue Free Java Download h

Why am | always redirected
to this page when visiting a
page with a Java app? » What is Java? » Dol have Java? » Need Help?

Release date July 26, 2017

» Learn more
» Report an issue
Why download Java?

Java technology allows you to work and play in a secure computing environment. Upgrading to the latest
Java version improves the security of your system, as older versions do not include the latest security
updates

Java allows you to play online games, chat with people around the world, calculate your mortgage interest,
and view images in 30, just to name a few.
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Flashing Tools (infineon
2. XMC4200 Serial Port Drivers

» If you are plugging in the XMC4200 for the first time into your PC/laptop, you
will receive an error.

“JL. Device driver software was not successfully installed * *
s Chek bere fod details,

»  XMC4200 serial drivers are part of deliverables, comes under the folder ‘Driver’.

b Distance2Go b XMC4200 serial driver ~|4
- O e
Name : Date modified Type Size
& | Infineon_CDC_Driver.inf b 28.05.2014 08:16 Setup Information 2KB
- vcom.cat 28.05.2014 08:16 Security Catalog 9KB
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Flashing Tools (infineon
2. XMC4200 serial port drivers

Installation Steps:
1. Right click on "My Computer”
2. Click "Manage” and a Computer Management window will be opened.

3. Click on “"Device Manager”

k’? Altium Designer » -

N Jain Arushi (IFAG
(5 vicrum uc-prone xvic Bl o s v AD File Action View Help
@ Microsoft Word 2010 4 Dociments ‘* * | Zl | ﬂ | ﬂn‘:’f'
: Pictures —
Sticky Notes 4 & Computer Management (Local)
A Altium Designer (in AD14) > a il System Tools

i (5 Task Scheduler
i {2 Event Viewer
I» @1 Shared Folders

P:" Microsoft PowerPoint 2010 »

(nfineon Deneon

E Demo Builder 11 Map network drive...
— Disconnect network drive... b ‘%J Local Users and Groups
j Sething Started ’ Show on Desktop [+ @ Performance

] & - (
! Connect to a Projector s :é Device Manager
Properties =
Fl
5 DAvE432 =3 Storage

= Disk Management
{Remote Desktop Connection - - -
k“ s Services and Applications

| ] Programs

l Search programs and files el Shut down PH
il
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Flashing Tools
2. XMC4200 Serial Port Drivers

4. Now connect the demo board to the computer
via USB and the board will be detected under

the “"Other devices” category.

5. Right click on “Unknown Device”

=4 Device Manager

(infineon

File Action View Help

e | B HE &

42 MUCNCZCO294FTD

b % Batteries

b 12 Biometric Devices

b 1M Computer

j: «—y Disk drives

- B Display adapters

23 DVD/CD-ROM drives

b % Human Interface Devices

» Cg IDE ATA/ATAPI controllers

b @ IEEE 1394 Bus host controllers

b !j Imaging devices

S Keyboards

b ﬂ Mice and other pointing devices

b i Modems

b - Monitors

Al.:" Network adapters

-¥ Intel(R) 82577LM Gigabit Network Connection
¥ Intel(R) Centrino(R) Advanced-N 6200 AGN
-&F TAP-Win32 Adapter V9

Pseudo-Interface

&% Teredo Tunneling

@ Unknown device
- £57] PCMCIA adapters

3 Ports (COM & LPT)

- Y3 ECP Printer Port (LPTI)

b D Processors

5 B SD host adapters

b |} Security Devices

b j Smart card readers

b -% Sound, video and game controllers

> M System devices
> - Universal Serial Bus controllers
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Flashing Tools

2. XMC4200 Serial Port Drivers

6. Click “"Update Driver Software”

7. Select "Browse My Computer for Driver Software”.

8. Now browse to the directory where the drivers are stored (it's part of deliverable

in our case under ‘Driver’ folder) and click “"Next”.

) Device Manager
File Action View Help

|¢==m|E|Hel & F &S

‘ ) Update Driver Software - Unknown Device
-y

&% MUCNCZC0294FTD
9 Batteries

@/ Biometric Devices

) Bluetooth Radios

1% Computer
< Dick drives
Display adapters
DVD/CD-ROM drives

U5 Human Interface Devices

. IDE ATA/ATAPI controllers

§ IEEE1394 Bus host controllers

5 Imaging devices

= Keyboards

4 Mice and cther peinting devices
(5] Modems

Moenitors

Network adapters

W Bluetooth Device (Personal Area Metwork)
¥ Bluetooth Device (RFCOMM Protacel TDT)
&¥ Intel(R) 82577LM Gigabit Network Connection
A Intel(R) Centrino(R) Advanced-N 6200 AGN
TAP-Win32 Adapter V9
¥} Teredo Tunneling Pseudo-Interface
4 -[[ Other devices

LA

o

I~

I Portable Devices .
+ 77 ponscoma e DiSable
Y§ ECP Printer Port (L .
7
I Processors Uninstall
il SO host adapters.
[3 Security Devices

% Sound, video and gan

\ G sngecontslers  Properties

M System devices

How do you want to search for driver software?

9 Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

< Browse my computer for driver software h

Locate and install driver software manually.

[cancel |

o]

&5 1 Update Driver Software - Unknown Device

oy e se<e . Update Driver Software,  fr—

4 smanewardess  oCanN for hardware changes

@ Universal Serial Bus controllers

2017-08-01

Browse for driver software on your computer

Search for driver software in this location:

_eu.infineon.com\chakraab\My documents\XMC4200 serial drive: Jlig Browse... \(

infineon

¥| Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

hei ) (e
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Flashing Tools (infineon
2. XMC4200 Serial Port Drivers

9. After successful installation, the board is listed under “Ports” category in “"Device
Manager” tab of computer management window.

> Note down the COM port to which the board is connected. This will be helpful for
working with the software later.

File Action \iew Help
i

|®$|9;Dﬁ|i’<|£.&ib

&' Computer Management (Locg| 4 3- MUCNRSOMZZED

4 ]f[’& System Tools > E‘ Batteries
> @ Task Scheduler > a Bluetooth Radios
+ @ Event Viewer > -1 Computer
> @l Shared Folders >y Disk drives

B Display adapters

Qﬁ Human Interface Devices

g IDE ATA/ATAPI controllers

’—ﬁ Imaging devices

= Keyboards

1] Memory technology driver

¥ Mice and other pointing devices

| Monitors

¥ Network adapters
:'." Bluetooth Device (Personal Area Network)
:'." Bluetooth Device (RFCOMM Protocol TDI)
:'." Intel(R) Dual Band Wireless-AC 8260
:'." Intel(R) Ethernet Connection 1219-LM
:"; Teredo Tunneling Pseudo-Interface

"% Ports (COM & LPT)

blogy - SOL (COM3)
"% JLink CDC UART Port (COM112)
» [ —

> -} Security Devices
> wg» Smart card readers
> {2 Sound, video and game controllers

[ S PR S

» & Local Users and Groups
» (@ Perfarmance
&= Device Manager
4 =3 Storage
I = Disk Management
» B Services and Applications

h ¥ T T T T T TV

4 11 5
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Tools Installation

1. XMC Flasher
2. XMC 4200 Serial Port Drivers

1. Radar GUI

1. DAVE
2. Segger J-Link
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Visualization Tools infineon
1. Radar GUI

1. Download the latest version of Radar GUI.

http://download.hitex.de/RadarGUI

2. Click on “I accept”.

- T TR WEER. W TEE_—
(7 Y \ hitexde. )

Home 135 Gerrit &= xMc Docs [J XMC Acacemy = DAVE & pmm._coding & Teleconterencing I ePortal $§ Jwa RS mmw SW i Gt
Please read the ing terms and diti carefully.

The finalization of your download is only possible if you agree to such terms and conditions.
By choosing the check box “I accept” below, you agree to have read and to be bound by the terms and conditions set forth below.

. Any purchase order placed hereunder and any confirmation thereof, if any, is subject to the proviso that the required export licenses and other statutory
authorizations are granted by the competent export control authorities and that no impediment arises from the applicable export laws and regulations. Neither
the placing of an order nor its confirmation creates a legally binding sales contract. Only the delivery of the product by Infineon constitutes final acceptance.

. In case the required export licenses or other legally required approvals are not granted within six (6) months after the confirmation of a purchase order
hereunder; then the purchase order shall be void upon Infineon Technologies' request.

. You shall neither (a) use any products, information, software and technology delivered by Infineon Technologies in or in connection with nuclear technology or
weapons of mass destruction (nuclear, biological or chemical) and carriers thereof nor (b) supply military, paramilitary, police, intelligence agencies or civil
administrations of such institutions or other institutions acting on behalf of them, with products, information, software or technology which are subject to export
licensing requirements.

. By clicking on "l accept" you agree to comply with all applicable national and international laws and regulations, including but not limited to the EU and US
export control laws and regulations as well as the applicable anti-terrorism regulations. You also agree not to export, re-export or transfer any products
developed with or using products, information, software or technology delivered by Infineon Technologies, in violation of any applicable laws or regulations of
the competent authorities,

| accept | the above mentioned terms and conditions. e

N

w

IS

3. Save and install the Deneon Radar GUI executable file

- Radar GUI is preinstalled in Deneon after installation

Note: The initial download page will change in the future, as soon as the IFX
webserver is available.
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Visualization Tools infineon
1. Radar GUI e

4.  Click on the Deneon link after installation on your Desktop.
[a

Denecon

5. If a new update is available for the Radar GUI, then please click on the green button
labeled “update” appeared right to the start button in the Radar GUI tab. After update,
Deneon will restart and then click “Start” button in the Radar GUI tab to run GUI.

EDeneon

\- DENEON Search for apps odinstaller | @ = £F

My Tools  Intallable Tools

QR Easy Setup Radar GUI

Update

.
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Visualization Tools infineon
1. Radar GUI (lneon

6. Radar GUI at the start checks the compatibility of firmware version running in the
connected device and will prompt by a message to follow the links to update the firmware.

View Settings

f@ICOMB v} Jny | Frame Interval [ms]: | HOININE| =]
Frequency Domain ITime Domain i [CEC I =
ADC Values
1
0.8+
2
= 0.6
=
=
£ 04
<
0.2
Info |i‘
0 ! ! ) ' There is a newer firmware version available for your device. i ! ! ! '
0 005 01 015 02 Please download the latest version from MyICP and follow the instructions in the & 08 085 08 095 1
QuickStartGuide.

Polar View =2 ~ O | Range View =2 = g

N/A N/A

Target List View 2 = 8
No. Velocity [km/h] Distance [cm] FFT Magnitude

—— 1 g

0 5 10 15 20 25 30 35 40 45 50
Distance [m] o

v1.0.8.201709211258 | Disconnected | No Device I No motion | Target Count: N/A  |Ten/a I ToNgA
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Visualization Tools
1. Radar GUI

(infineon

Default layout of Radar GUI for D2G demo boards is depicted in the following picture. For
further help on Radar GUI please click on the help section as shown in the figure below.

View Settings

80°

90°

v1.0.8.201709211258 (FW v1.0.0)

5 5
Distance [m]

| Acquisition

| Distance2Go | No mation

| Target Count: 1

‘ICOMB vlf ) | Frame Interval [msl: 100 | [ | @[> || [ @ b
Frequency Domain | Time Domain EZ} QQ
) ADC Values
08
% 0.6+
=
=
= —
E 04 Antenna 1, I Signal
< — Antenna 1, Q Signal
02
0 f T f t t f t f T T T t t f T T T T T T t T T T
] 10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200 210 220 230 240
Samples
Polar View i3 = O | Velocity View &2 = O | Range View &2 = 0
Object Angle [°]
10° o -10°
0.00 km/h Range = 262 cm
Target List View 2 = g
No. Velocity [km/h] Distance [cm] FFT Magnitude i
-70° 1 0.00 262 949 B

[T 9dBm |T:400°C

2017-08-01

Copyright © Infineon Technologies AG 2017. All rights reserved.

Infineon Proprietary




Visualization
1. Radar GUI

Tools

Go through the different sections of this Radar GUI help.

(infineon

&) T - El X
Help & ]
# =

» Deneon Launcher
4 Radar GUI
4 Radar GUI Application
» Main Application Window
» Chart tab view features
» Radar GUI Perspective
4 Recording and Playback
Default path
Recording options
» Recording Data Format

Radar GUI Application

The Radar GUI software is JAVA based Graphical User Interface (GUT). Tt represents graphical support for Infineon’s radar devices and enables
showing raw and processed data from a device, and provides features for enhanced data display and data graphical analyzes.

Main Application Window

After Radar GUI application has been launched, the followng window will appear (see Figure 1).

4

Recording -
=B
Playback ) Radar GUI ]
View Settings
-J qll Frame Interval [ms}: D ' @ = o
Frequency Domain 22 | Time Domain @a=o
Spectrum
2000
1500
)
=
3
= 1000
=3
E
<
500
0 T T T i T T T T T t 1 i !
0 0.05 01 015 02 0.5 03 035 04 045 05 0.55 06 055 07 075 08 085 03 095 1
Distance [cm]
Polar View 52 = O || Velocity View 2 = O ||Range View 2 = O
Object Angle [°]
10° o -10°
»r L ——
0 _ — "
> = N/A N/A
I
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(infineon

Tools Installation

1. XMC Flasher
2. XMC 4200 serial port drivers

1. Radar GUI

1. DAVE
2. Segger J-Link
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Firmware Development Tools infineon
1. Installing DAVE (fheon

1. If you have a previous version of DAVE installed, check your hard drive
location:

C:\Users\"your login name”\Infineon\D_LibraryStore_4.1
m’ If this folder exists, rename or delete it.

2. Download the latest version of DAVE from

. . Forum Ecosystem
www.infineon.com/dave
XMC™ MCUs Rapid Prototyping To¢

e XMC™ Flasher T
® XMC™ Link, Fun
® XMC™ Pinout Tc
e Others

— Scroll down to the “"DAVE™ Download” link.

Free Eclipse based integrated develop
code repository, hardware resource m
A complete download package is prov
DAVE™ Release Note

DAVE™ ‘
Download can take up to 1 hour! ,

Develc . nt environment to modify
DAVE™ SDK is available as separate tc

DAVE™ SDK I
All DAVE™ APPs can be downloaded a

Ready to use APIs for peripherals whic
= Altium, ARM/KEIL, Atollic, IAR Systems
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Firmware Development Tools (ﬁfﬂmon
1. Installing DAVE (cont "d)

3. Select either the 32-bit or 64-bit version depending on your
system (leave DAVE™ SDK unchecked as it is not needed)

4. Fill out the form and you will get a personal download link
(Infineon Free Dave™ (Version 4)

Please register here Professional development platform for XMC™
microcontrollers

Select the DAVE™ package(s) you would like to download
DAVE™ Packages* [ DAVE™ for Windows 32-bit

] for Windows 64-bi
DAVE™ for Wind 64-bit
j for Windows 32-bil
DAVE™ SDK for Wind 32-bit
for Windows 64-|
DAVE™ SDK for Wind 64-bit

Please fill-in your personal data
Email Address® | 1
|

HE =@

First Name™

AEEEO
AEEEDOC

imanERC
EBEEREC |

Last Name*

EREEE [

EEEEEC
E_ HE B =@
B EE ©

Company*

Business Phone* [ J
e

Country*
City* Thank you for your registration!
Target Application*®
v

Yes, | like to be part of the Infineon Community™®

Please download your software here:

| agree that my personsl dats maintained sbove can be gathered, processed and used for
sales promotion and market research by Infinean Technologies AG and its lieensed
distribution partners.

4 Privacy Policy* Sincerely,

| have read the privacy policy and agree with it. J o —

S Your Infineon Community Team

Submit

2017-08-01 Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary



Firmware Development Tools (in’fﬁeon
1. Installing DAVE (cont "d)

Unzip the downloaded zip file on your hard drive

6. Depending on your PC, you may need to have administrator
access to install the software.

7. Start the executable and make sure to install DAVE, the Library
Store and SEGGER drivers (all boxes checked)

¥ DAVE™ v4 X

| 25 /
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Firmware Development Tools
2. Installing J-Link

(infineon

8. Accept license agreement and keep clicking "Next” then click

“Finish”.

9. When the Segger JLINK installation starts, click "Next”.

2017-08-01

SEGGER - J-Link V5.10! Setup

»
/ SEGGER

Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary

Welcome to SEGGER - J-Link
V5.101 Setup

Setup will guide you through the installation of SEGGER -
Jink V5. 10l

It is recommended that you dose all other applications

before starting Setup. This will make it possible to update
relevant system files without having to reboot your

computer,

Click Next to continue.

X




Firmware Development Tools (infineon
2. Installing J-Link (cont’d)

10. Keep clicking “"Next”.

11. If something like the screen below appears, click “"Select All” (if
it is not greyed out) and then "OK".

12. Click “Finish”.

The following 3rd-party applications using JLinkARM.dll have been found:

—\
Wuld like to replace by this version.

The previous version will be renamed and kept in the same folder, allowing manual "undao".
In case of doubt, do not replace existing DLL[s).
You can always perform this operation at a later time via start menu.
Ok ancel I

|
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afineon

Table of Contents

Hardware Description

Tools Installation

Demo Distance2Go USB Connections
Building, Flashing and Debugging

Radar GUI
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(infineon

Demo Distance2Go USB Connections

USB No. 2

Main D2G Module

[CYSNCICNCICNE]
m- <

2
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Demo Distance2Go USB Connections (iﬁﬂwon
Firmware flash

1. Only connect USB to Debugger module
- To flash the Firmware
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Demo Distance2Go USB Connections Infineon
Radar GUI heen

2. Only connect USB to Main D2G module

— To use Radar GUI

Note: Firmware must be flashed beforehand otherwise flash it
using first connection scheme

w2 Bl
— :

infineon ¢

*
|
! 2
| i g
——————
|| ——
\V/ ¥
¢ [
=, *°
» 1= AR
|

} wosebs LA
H3DO3IS/,
______\
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Table of Contents

Hardware Description

Tools Installation

Demo Distance2Go USB Connections
Building, Flashing and Debugging

Radar GUI
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Building, Flashing and Debugging (infineon
Overview

Two ways to proceed from this step to flash the firmware:

1. XMC Flasher
2. Dave Project
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Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

1. Open the XMC flasher .jar file and click on the connect button to select the
device name

@ ™ —_— oy 2X
e I nehins and Nabuwrnnins 7555
File  Configurations Target Log About
Connect.. G— Disconnect.. Select File..
File:
Connection Status: Not connected

Selected Emulator Serial Number:
Selected Device Name:

Unique Chip ID:

(infineon
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Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

2. Select the Device name form new window opened (XMC4200-256), then click
‘OK’.

» ™ | = ™~ P
(G lnehins and Nabuwnnins 5.
File  Configurations Target Log About f
Connect.. Disconnect.. Select File..
¥ Select Device Name to connect ﬂ

Connection Status:

Selected Emulator Serial Number: .
List of Targets:

Selected Device Name:

Unique Chip ID: AMC1404-0200 ~
KMC4100-128

XMC4104-128

XMC4104-64

XMC4108-64

(infineon | |EEEDEE
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Building, Flashing and Debugging Overview
Via XMC Flasher cont’d

(infineon

3. If connection is successful, then ‘Connection Status’ would be connected. You
can then see the ‘Unique Chip ID’ as well.

2017-08-01

File  Configurations Target Log About
Connect.. Disconnect..
File:
Connection Status: Connected - ———
Selected Emulator Serial Number: 591105238
Selected Device Name: XMC4200-256
Unique ChipID:  B5200004067038A0030292804] o

(infineon

Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary

Select File..

Erase

oo




Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

4. After connection is done, select the .hex file (firmware is flashed through .hex
file) by clicking on Select File button.

File  Configurations Target Log About

Disconnect.. Select File.. b

File:

Connection Status: Connected
Selected Emulator Serial Number: 591105238
Selected Device Name: XMC4200-256
Unique Chip ID: B200004067038R0030R928041

Erase

(infineon g%
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Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

5. Navigate to the binary folder containing Radar_D2G_FMCW.hex file and select it.
6. Click on ‘Open’ in the dialogue box.

Select File [

-
@ Ov| « Workspaces » DAVE-43 » Distance2Go » Radar D2G_FMCW » Debug » v| +4 | | Search Debug P
Organize ¥ New folder = O @
N Name Date modified Type Size
| Libraries
Algorithm 21/08/2017 15:40 File folder
‘L. Docume -
. i Dave File folder
4. Music
. Distance2Go 21/08/2017 15:40 File folder
= Pictures
3 Driver 21/08/2017 15:40 File folder
& Videos
HostCommunication 21/08/2017 15:40 File folder
Libraries 21/08/2017 15:40 File folder
& Compute ) _ _
- Math 21/08/2017 15:40 File folder
=¥ System[ i ) - B
X L Peripherals 21/08/2017 15:40 File folder
& aliassad =
Startup 21/08/2017 16:28 File folder
— swdepo
Radar_D2G_FMCW.hex b 21/08/2017 16:29 HEX File 264 KB
< RFS_AE|
@ MNetwork
& My Backu
File name: Redar_D2G_FMCW hex v [HEx-Files(nex) -
_>l Open l I Cancel l

2017-08-01 Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary



Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

7. Successful selection of hex file will list the name of .hex file under ‘Select File’
button.

8. Now click ‘Program’ button.

File  Configurations Target Log About
Connect.. Disconnect.. Select File..
File:  Radar_D2G_FMCW.heX G —
Connection Status: Connected ‘ Program _
Selected Emulator Serial Number: 591105238 :
Selected Device Name: XMC4200-256 Verify
Unique Chip ID: B20000406703820030R928041

Erase

(infineon
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Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

9. SEGGER progress window will open. It will also verify if the .hex file is flashed or
not.

. XMC™ Flash - b =1
(7T Flasher anlle sn e snu sl
. ile..
[ - _—.‘ I
SEGGER J-Link V6.00d - Flash download (192 KB) N hes
‘ Compare 0.329s
Erase 0.000s
1| Program 0.000s
Werify 0.000s
Comparing rang_DxDCDEDDDD Ox0CO3FFFF (128 KEI) 0.329s

Programming in progress...

(infineon
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Building, Flashing and Debugging Overview Cinfineon
Via XMC Flasher cont’d

Congrats! You have successfully flashed the firmware using XMC Flasher.

# XMC™ Flasher — < |

¥ Programming succeeded ﬂ

4| Programming is successful ! o

Operation completed

(infineon
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Building, Flashing and Debugging (infineon
Overview

Two ways to proceed from this step to flash the firmware;

1.
2. Dave Project
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Building, Flashing and Debugging (infineon
DAVE Project

1. Import/Open FW project in DAVE
2. Connect Distance2Go kit
3. Create Debug Configurations

- To start flashing and debugging within the DAVE project
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Building, Flashing and Debugging =
DAVE Project cont’d (afineon.

1. Import/Open Distance2Go firmware project in DAVE

a. Navigate to File > Import
b. Infineon > DAVE Project

& DAVE CE - DISTANCE2GO FW/main.c - DAVE™ - C:A\Workspaces\D & Import =R
Edit Source Refactor Mavigate Search Project DAVE Sel
New Alt+Shift+N » slect Nd
Open File... H
Close Ctrl+W
Close All Ctrl+Shift+\W Select an import source:
o Ctrl+S type filter text
&l Save As.. » = General
Save A Ctrl+Shift+5S s = CIC++
Revert » = Git
Move... a (= Infineon

—

Rename... F2 é S
Refresh F5 L s

DAVE Project From Local Library Store

Convert Line Delimiters To L4

» = Install
Print... Ctri+P » [ Plug-in Development
Switch Workspace 3 » = Run/Debug
Restart = 1:::1
o=
I fa  Import.. I
3 Export..
Properties Alt+Enter

1 ifxRadar_D2Go.c [DISTANCE2GO_FW/..]
2 main.c [DISTANCE2GO_FW]
3 mcu_xmc.c [DISTANCE2GO_FWY/.../src]

4 mcu_xmc.h [DISTANCE2GO_FWY/.../inc] l‘/:;, < Back Mext > Finish

Exit
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Building, Flashing and Debugging

DAVE Project

c. Check “"Copy Projects Into Workspace”

d. Select "Browse” beside “Select Root Directory”

2017-08-01

% Import DAVE Projects l S] e’ S

Import DAVE projects
Select a folder/Archive to search for existing DAVE projects.

@ Select Root Directory Browse...

(C) Select Archive File Browse...
Project List:
Select All

} Copy Projects Into Workspace

Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary
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Building, Flashing and Debugging (infineon
DAVE Project

d. Select ‘Distance2Go’ Folder from location where you have extracted the .zip file of DAVE
project. For example, here we have in the USB drive
INTENSO/AII_Deliverables/Distance2Go

Browse For Folder ﬁ

Select Directory

4 |8 Computer
- &L, SystemDisk ()
a4  INTENSO (D:)
4 All_Delrverables

> | 4 | Distance2Go

m

4 | Radar D2G FMCW A5
¥ m 3
Folder: Distance2Go
Make Mew Folder | [ (8]14 ] | Cancel

_

Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary
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Building, Flashing and Debugging (infineon
DAVE Project cont’d

e. The Project File should appear under Project List. Press
‘Finish’.
f. Check ‘Copy Projects Into Workspace’

W [mport DAVE Projects

Import DAVE projects
Import Existing DAVE Projects

(@) Select Root Directory C\Workspaces\DAVE-4.3\Distance2Go

(C) Select Archive File

Project List:

Radar_D2G_FMCW(C\Workspaces\DAVE-4.3\Distance2Go\Radar_D2G_FMCW) Select All

Deselect All

Refresh

> Copy Projects Into Workspace

N

Next > [ Finish l l Cancel

e
)
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Building, Flashing and Debugging

DAVE Project cont’d

> The following should appear. Expand the ‘C/C++ Projects’ dropdown

| DAVE CE - Radar_D2G_FMCW/mainGe DAVE™ - CAWorkspaces\DAVE-43\D2GoTest NS =

File Edit Source Refactor Navigate Search Project DAVE Window Help
7Bl G huE G DO # O~y oy Oy

xplorer

0@ C/C++ Projects &2 Project

a ﬁ Radar D2G_FMCW [ Active - Debug |
i @ Includes
I (= Algorithm
i = Dave
I (= Distance2Ga
I = Documents
& & Driver
I = HostCommunication
I = Libraries
i = Math
I = Peripherals
I (= Startup
v B config.h
© [ definesh
© [€ mainc
v (€ micrium_gui.c
© [H versionh

== APP Dependency Tree &

Search filter

= B

2l EE -

-

1

tee/E=0

Clear

» km ADC_MEASUREMENT_ADV_G1
» ki ADC_MEASUREMENT ADV_ G2
ku CMSIS_DSP.O
k= DIGITAL_I0_BGT_POWER_ENABLE
4w DIGITAL IO_PLL CE
k= DIGITAL IO_PLL_ MOD
k= DIGITAL_IO_PLL_TRIG1
4= DIGITAL IO_PLL_TRIG2
4= DIGITAL IO_SPIM_CLK
4= DIGITAL_IO_SPIM_CS_BGT24
ku DIGITAL IO_SPI M _CS PLL
4= DIGITAL_IO_SPI M_DATA
» b DMA_CHI
» b DMA CH Q
» & DMA_DOPPLER CH_1

»

m

2017-08-01

main.c £2
2% \file main.c]
6
7= 1*
8 ** Copyright (C) 2017 Infineon Technologies AG
9 ** all rights reserved.
10 *k
11 *k
12 Xk

13  ** This document contains proprietary information of Infineon Technologies AG.
14 ** Passing on and copying of this document, and communication of its contents
15 ** is not permitted without Infineon's prior written authorization.

21 1. INCLUDE FILES

25 #include <DAVE.h> // Declarations from DAVE Code Generation (includes SFR declaration)

26

27 #include "defines.h" // Contains all the definitions of the header files used in base firmware and

28
29= /*
30

31 2. GLOBAL DATA

32

35 uintle_t firmware_version[3] =
36 {
37 FlW_VERSION_MAJOR,
38 FlW_VERSTON_MINOR,
<

«a APP Dependency «« HW Signal Connectivity & Console 2 | Properties '/ Problems

No consoles to display at this time.

Quick Access

Host USB communication

‘| 1 | © DAVE IDE (& DAVE CE |4 Debug

infineon

AT

= B

-

m

»

M B~~~ =0

Copyright © Infineon Technologies AG 2017. All rights reserved.
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Building, Flashing and Debugging
DAVE Project contd

There are two ways to build a project:

1. Build Active Project via toolbar button

2. Right-click on ‘Active Project’ - ‘Build Project’

& DAVE CE - Radar_D2G_FMCW/main.c - DAVE™ - C\Workspaces\|

File Edit Source Refactor NMavigate Search Project DAVE

tuEHTOEH O

_';'""‘?EEJBE@E

B C/C++ Projects &2 =g
| BESR ~
4 [ Radar_D2G_FMCW [ Active - Debug | s
» [l Includes
+ = Algorithm
» = Dave

> = Distance2Go
> = Documents
> = Driver

> = HostCommunication

> = Libraries

» [= Math

> = Peripherals

» [= Startup

> [W configh

- [ definesh

+ & main.c

+ & micrium_gui.c
- [l version.h

2017-08-01

m

Copyright © Infineon Technologies AG 2017. All rights reserved.

(infineon

w DAVECE :Edar_DZG_FME w/maTMEEEE! = iEEDrksﬁ\

File Edit Source Refactor Mavigate Search Project DAVE

2Bl huE S TOR#H O%
B8 C/C++ Projects 2 | [ Project Explorer = d
W BES v
=3
4 Radarj New R
> i Incl

- & Alg Go Into
» = Dav Open in New Window

» = Dist —
. & Doc n _ex _ _
. & Driv Build Configurations

. & Hos Make Targets

. & Libr Build Project| e —

. &= Mat Clean Project

> = Peri| [& Copy

s = Sta Paste

- [0 cont ¥ Delete

- [ defi Move...

> g mai Rename..
> € mic

s Import..
> [h vers

g Export..

Infineon Proprietary




Building, Flashing and Debugging (infineon
DAVE Project cont’d

Confirm successfully built by looking in the console

«s APP Dependency «s HW Signal Connectivity & Console 2 [ Properties /! Problems 4B B =&l EByvy=0
CDT Build Console [Radar_D2G_FMCW]
"Invoking: ARM-GCC Print Size'
"C:/DAVEv4/DAVE-4.3.2/eclipse/ARM-GCC-49/bin/arm-none-eabi-size" --format=berkeley "Radar D2G FMCW.elf"
text data bss dec hex filename
93938 1916 36200 132054 203d6 Radar_D2G_FMCW.elf
'Finished building: Radar_D2G_FMCW.siz'

"Invoking: ARM-GCC Create Listing'

"C:/DAVEv4,/DAVE-4.3.2/eclipse/ARM-GCC-49/bin/arm-none-eabi-objdump” -h -S "Radar_D2G_FMCW.elf" > "Radar_D2G_FMCW.lst"
'Finished building: Radar_D2G_FMCW.l1st'

17:53:39 Build Finished (took 4@s.244ms) <

4 (I
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Building, Flashing and Debugging
DAVE Project contd

(infineon

In order to flash and debug the firmware in DAVE, need to follow these step.

1. Select the debug configurations by clicking on the drop down menu of

Debug button as shown in Figure below, i.e.

Configurations’

‘Debug’ - ‘Debug

& DAVE CE - Radar_D2G_FMCW/main.c - DAVE™ - C\Workspaces\DAVE-43\Distance2Go (W ... . 0 s

2017-08-01

File Edit Source Refactor Mavigate Search Project DAVE Window Help

EQIZI#OE#EO‘I%&v!Ig

| » B8 = et vl e eSS v
5. M@ C/C++ Projects 2 r[\:nPrcnject Explorer = @‘ Debug Configurations.. ( !
wn B < pL \file main.c[]
4 i Radar_D2G_FMCW [ Active - Debug ] 6
- 3 Binaries 7
. & Includes g *x Copyr“:ilght (C) 2017 Infineon Technologies AG
) 9 *% All rights reserved.

» = Algorithm 10

> = Dave 11 **

» = Debug 12

» (= Distance2Go 13

> = Documents il—:r

+ = Driver
+ = HostCommunication
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Building, Flashing and Debugging T
DAVE Project contd (afineon.

Following debug configurations are opened.

2. Double click on the ‘GDB SEGGER J-Link Debugging’ to create debug
configurations.

% Debug Configurations e st SN B R X

Create, manage, and run configurations @

I - Press the ‘New' button to create a configuration of the selected type.
[€] GDB MikroE Debugging
== €] GDB SEGGER J-Link Debugging

b

v

Configure launch settings from this dialog:

=| - Press the 'Duplicate’ button to copy the selected configuration.

X

- Press the 'Delete’ button to remove the selected configuration.

b

- Press the ‘Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the 'Perspectives’ preference page.

Filter matched 2 of 22 items

G B
@ Debug Close

2017-08-01 Copyright © Infineon Technologies AG 2017. All rights reserved. Infineon Proprietary



Building, Flashing and Debugging T
DAVE Project contd (afineon.

Click on the ‘Debug’ button to flash and debug the DAVE project.

W Debug Configurations

Create, manage, and run configurations

X | B3~ Name: Radar_D2G_FMCW Debug
type filter text )l Main
[£] GDB MikroE Debugging )
. . Project:

4 |c| GDB SEGGER J-Link Debuaain

[£] Radar_D2G_FMCW Debug Radar_D2G_FMCW
C/C++ Application:

Debug\Radar_D2G_FMCW.elf

qt‘a’*Debugger I+ Startup| % Source | Common

Variables... ] l Search Project... ] l Browse... ]
Build (if required) before launching
Build configuration: | Select Automatically v]
(©) Enable auto build (C) Disable auto build
@) Use workspace settings Configure Workspace Settings...
Filter matched 3 of 23 items A neve
(?} é [ Debug l l Close
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Radar GUI

1. Click on the Deneon link on your Desktop.

—
Infineon

Deneon

2. Click start button in radar GUI tab

# ' Deneon Laus ineon one pl
XDENEON Search for apps e Old Installer | Help 1=
|
MyTools Installable Tools
QR Easy Setup Radar GUI XMC Flasher
—
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» Infineon BGT24MTR11 - 24Ghz radar IC — Datasheet

https://www.infineon.com/dagdl/Infineon-BGT24MTR11-DS-v03 01-
EN.pdf?fileld=5546d46256fb43b301576b97728c07f5

»  Infineon XMC4200 32-bit ARM Cortex™-M4 Microcontroller - Datasheet

https://www.infineon.com/dadl/Infineon-XMC4100 XMC4200-DS-v01 03-
EN.pdf?fileld=db3a30433afc7e3e013b3cf9b2816573
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